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Data Object

The Data Object binds data to objects in a Lyric Scene. The Data Object can retrieve data at
a specified interval, based on scene events or can be timeline driven using keyframe
commands. Data sources include Text, XML, RSS, Web, JSON, Excel, Access and Google
Docs. This data can also be filtered/formatted using easily configurable options within the
Data Object editor.

Adding a Data Object

To Add a Data Object and animation track to a composition click on the
Tools>DataObjects or click the Data Object icon in the scene objects toolbar. ﬂ

This will open the Data Object settings panel.

7 Data Dbject Settings

% Source Filter =

! Column | [ eat
Avsilable Sources 48 Back
@ Use All Rows
Text R RSS [@) Web JSON #
= = A < Wi G hd i -
Excel Access Database AP Web Feed ¥ Images iz fize Ty | i ]
% Movies Google [Z] Parameters Custom Query

Binding &) Tree [] Cell Clear Al Bindings

Barl
Bar2

Bar3
Bard
Bullet Text 1
Bullet Text 2
Bullet Text 3
Bullet Text 4

Version: 2.0.0.51

The Data Object Settings panel is divided into 3 areas.

e Available Sources displays a list of data formats that can be associated with
templates, images and keyframes. When a source is selected an additional
configuration menu, specific to that type of data source, is displayed.

e Binding displays the templates, images, objects and keyframes in the scene that can
be data bound, as well as the data feed in columns and rows. This is where the
association of a scene object to a data cell, column or tree is configured.
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e Filter is used to display only content that fits within a defined parameter. Changes to
the data filter are reflected in the Binding Preview in real time. The filter can be used
to remove content not desired in the data feed.

Configuring a Data Source

To configure a data source to update a scene (image, object, template, keyframe) select from
the Available Sources listed.

<3 Back
The Back button becomes active when a data source has been configured and

can be used when changing data sources (i.e. from XML to RSS).

Text
Text Configuration @

Teut File

[] Delimiter -
[] Us=e First Line as Column Headers
[ Use Encoding

| Western European (Windows) = | Code Page 1252

[] Maintain Connection

0K ] [ Cancel

Text File: Select a text file from the local file system as the data source.

Delimiter: Specifies if each line of text is treated as a single piece of data, or if delimiters
within a line of text split the line into columns. The default delimiter is a comma (,). If enabled
(checked) and a delimiter (e.g., comma, slash, etc.) is specified, then the specified character
acts as the delimiter for separating columns within the selected text file. If disabled
(unchecked), then the entire line of text is treated as one column.

Use First Line As Column Data: By default, every line in the text file is considered data;
however, sometimes the first line contains column header information instead. This setting is
disabled by default. If the first line contains column header information, then enable (check)
this setting. If the first line contains data, then disable (uncheck) this setting.
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Use Encoding: When a text file is selected, the Data Object will attempt to identify the text
encoding used in saving the file. This is necessary to ensure proper handling of Unicode text.
The Use Encoding property can be used to override the default setting.

Maintain Connection: If Maintain Connection is enabled, a connection to the data provider,
i.e., the text file, is maintained. This means that the file is locked and inaccessible to other
users/applications. If concurrent access to that particular text file is not needed, then it is
beneficial to maintain the connection. This setting is disabled by default.

To bind a scene object to text data see Data binding further in this document.

Local XML
The following parameters can be set in the XML Provider Configuration dialog:
Local XML Configuration @
XML File
Advanced

[] Transform XML with Customn XSLT

[ Transform Attributes ] Allow DTDs

Strip Embedded HTML Tags

oK ] [ Cancel

XML File: Select an XML file from the local file system, or a Network (UNC) path, as a data
source.

Advanced parameters can be set:

Transform XML with Custom XSLT: Allows the user to specify a separate XSLT file, which
transforms the provided XML into a different and more useful form prior to processing by the
Data Object.

If disabled (unchecked), then the XML will be left as is.

Transform Attributes: If checked, this option will convert XML attributes into XML nodes.
This may offer better results for XML files with data that is largely contained in attributes.
XPath queries will need to be modified accordingly. This option is typically only needed when
binding in either Cell or Column mode.

If disabled (unchecked), then the XML will be left as is.

Allow DTDs: Determines whether document type definition (DTD) validation rules should
apply. In most cases, this option should be disabled.
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Strip Embedded HTML Tags: It is recommended that any HTML tags be removed from the
XML, so as to clean up the code and help prevent unintended display issues. This is
particularly useful when working with RSS data. This setting is enabled by default.

If enabled (checked), then all HTML tags will be stripped out of the XML.

If disabled (unchecked), then the XML will be left as is.

Once configured and OK is clicked the table field will populate with different parts of the XML
that can be selected to make data binding easier.

Source
XML <A Back
Filz IhChannel Box HD Demo\Data Object Data Files\5tat Crewh\SOGAME. XML
Toble ;

sogame/goaliechanges (4
sogame/goaliechanges/goaliechange
sogame/penalties
sogame/penalties/pen

sogame/plays

sogame/plays/period

oo e fel e fn st dd S e mmbr e

To bind a scene object to XML data see Data binding further in this document.

RSS
The following Retrieval Options parameters can be set in the RSS Data Sources dialog:
RSS Configuration yE. =
Web Aekliess | Refreval Optione
Download Interval 30—»5». seconds
Soee Lecation AAppData%i\ ChyronHego\Data Object | . |

Strip Embedded HTML Tags

[7] Use System Proxy Settings

Web Address: Enter one or more URLs from which RSS data will be downloaded.
Download Interval: Specify the frequency with which RSS data will be retrieved.
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Save Location: Specify a local file system folder in which the RSS data will be temporarily
stored.

Strip Embedded HTML Tags: If enabled, this option will remove HTML formatting tabs from
each data field. This is particularly useful when working with RSS title and description data.
Use System Proxy Settings: This setting provides the ability to use a system proxy. This
setting is disabled by default.

If enabled (checked), then system proxy settings will be used to connect to the RSS data
source.

If disabled (unchecked), then system proxy settings will not be used to connect to the RSS
data source.

When configured a table will display in the Source area where the desired data can be
selected.

To bind a scene object to RSS data see Data binding further in this document.

Web

The following Retrieval Options parameters can be set in the Web Data Sources dialog:

Web Configuration @

Web Address

Retrieval Options

Download Interval 30 »2-::| seconds

Save Location :n‘\ppData %\ ChyronHego\Data Object i E]
Strip Embedded HTML Tags

[] Use System Proxy Settings

Advanced

[] Transform XML with Custom XSLT

[] Transform Attributes  [] Allow DTDs

[] Collapse Nodes

Web Address: Enter one or more URLs from which XML data will be downloaded.
Download Interval: Specify the frequency with which Web data will be retrieved.

Save Location: Specify a local file system folder in which the Web data will be temporarily
stored.

Strip Embedded HTML Tags: It is recommended that any HTML tags be removed from the
XML, so as to clean up the code and help prevent unintended display issues. This setting is
enabled by default.

If enabled (checked), then all HTML tags will be stripped out of the XML.

If disabled (unchecked), then the XML will be left as is.
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Use System Proxy Settings: This setting provides the ability to use a system proxy. This
setting is disabled by default.

If enabled (checked), then system proxy settings will be used to connect to the RSS data
source.

If disabled (unchecked), then system proxy settings will not be used to connect to the RSS
data source.

In addition, the following Advanced parameters can be set:

Transform XML with Custom XSLT: Allows the user to specify a separate XSLT file. This
transforms the provided XML into a different and more useful form prior to processing by the
Data Object.

If disabled (unchecked), then the XML will be left as is.

Transform Attributes: If checked, this option will convert XML attributes into XML nodes.
This may offer better results for XML files with data that is largely contained in attributes.
XPath queries will need to be modified accordingly. This option is typically only needed when
binding in either Cell or Column mode.

If disabled (unchecked), then the XML will be left as is.

Allow DTDs: Determines whether document type definition (DTD) validation rules should
apply. In most cases, this option should be disabled.

Collapse Nodes: When a data source provides multiple top-level nodes (elements) and
possibly child nodes (child elements), it may be advantageous to display them in the Binding
Preview as one table, rather than multiple tables. This option is only appropriate when
binding in either Cell or Column mode. This setting is disabled by default.

If enabled (checked), then each node/element of the entire data source will be represented
as a column. All columns will be elements of one table. It can result in a table with many
columns.

If disabled (unchecked), then the original table structure is displayed and the elements/nodes
would be spread among multiple tables.

To bind a scene object to Web data see Data binding further in this document.

JSON

The following Retrieval Options parameters can be set in the JSON Source dialog:
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J50OM Configuraticn @

URL

Retrieval Options

Download Interval '3U é seconds

Save Location .%AppData%\ChyronHeg chData Object ) B

Strip Embedded HTML Tags
[] Use System Proxy Settings

URL: Enter the remote location of the desired JSON data set.

Download Interval: Specify the frequency with which Web data will be retrieved.

Save Location: Specify a local file system folder in which the Web data will be temporarily
stored.

Strip Embedded HTML Tags: If enabled, this option will remove HTML formatting tags from
each data field. This is particularly useful when working with RSS title and description data.
If disabled (unchecked), then the XML will be left as is.

Use System Proxy Settings: This setting provides the ability to use a system proxy. This
setting is disabled by default.

If enabled (checked), then system proxy settings will be used to connect to the RSS data
source.

If disabled (unchecked), then system proxy settings will not be used to connect to the RSS
data source.

To bind a scene object to JSON data see Data binding further in this document.

Excel
The following retrieval option parameters can be configured for an excel data source.
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Microsoft Excel Configuration

Ewcel File

=]

[] Us=e First Row as Column Headers

[] Maintain Connection

oK ] [ Cancel

Excel File: Select an Excel file from the local file system as the data source.

Use First Row as Column Headers: By default, every line in the Excel file is considered
data; however, sometimes the first row contains column header information instead. This
setting is disabled by default.

If the first row contains header information, then enable (check) this setting.

If the first row contains data, then disable (uncheck) this setting.

Maintain Connection: If Maintain Connection is enabled, a connection to the Excel doc is
maintained. This means that the file is locked and inaccessible to other users/applications.
There is a latency cost involved in opening/closing a connection to a data source, so if
concurrent access to that particular Excel file is not needed, then it is beneficial to maintain
the connection. This setting is disabled by default.

To bind a scene object to Excel data see Data binding further in this document.

Access
The following retrieval option parameters can be configured for an access data source.
Micrasoft Access Configuration @
Access File

-]

Show System Tables

Maintain Connection

oK ] [ Cancel

Access File: Select an Access file from the local file system as the data source.
Show System Tables: Hidden by default, this will allow Access’ system tables to be shown.
This setting is enabled by default.
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Maintain Connection: If Maintain Connection is enabled, a connection to the Access doc is
maintained. This means that the file is locked and inaccessible to other users/applications.
There is a latency cost involved in opening/closing a connection to a data source, so if
concurrent access to that particular Access file is not needed, then it is beneficial to maintain
the connection. This setting is enabled by default.

To bind a scene object to Access data see Data binding further in this document.

Database
Lyric supports File, System and User DSNs. The user selects a local DSN file or one of the
already configured System or User DSNs.

DSM Configuration _ =
@ File DSN ' |™
() Systermn DSM : -|
) User DSN f -|
[C] Credentials
Maintain Connection OK ] I Cancel

The user can select from the following data sources:

File DSN: Select a DSN file from the local file system that references a local data source.
System DSN: Select a previously configured System DSN from the dropdown.

User DSN: Select a previously configured System DSN from the dropdown.

User and System DSNs can be configured in Windows Control Panel > System and
Security > Administrative Tools > Data Sources.

Credentials: If the DSN that is being connected to is password protected, ticking the
credentials box allows you to enter those credentials.

Maintain Connection: If Maintain Connection is enabled, a connection to the database is
maintained. This means that the file is locked and inaccessible to other users/applications.
There is a latency cost involved in opening/closing a connection to a data source, so if
concurrent access to that particular database file is not needed, then it is beneficial to
maintain the connection. This setting is enabled by default.

To bind a scene object to Database data see Data binding further in this document.

AP Web Feed

The following parameters can be set in the AP® Web Feed Credentials dialog:
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AP Web Feed Configuration @

Uszername

Password

[] Use System Proxy Settings

Savelocation  %AppData%\ChyronHego\Data Object | .|

Continue ] [ Cancel ]

Username/Password: Enter credentials for the AP Web Feed service.

Use System Proxy Settings: This setting provides the ability to use a system proxy. This
setting is disabled by default.

If enabled (checked), then system proxy settings will be used to connect to the AP Web Feed

data source.
If disabled (unchecked), then system proxy settings will not be used to connect to the AP

Web Feed data source.
Save Location: Specify a local file system folder into which the AP Web Feed data will be

temporarily stored.

To bind a scene object to AP Web data see Data binding further in this document.
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Images
Browse For Folder u
Browse to a directory containing image files.
4 | Project Folder -

[ | J 3D Objects
.. Clip Files
| Effects

[ | g File Sequences
.. Fonts

4 1 Images
|j. Carousel
. File Sequence
. Generic Elements
00 More Music Images
| texdures

[ Make Mew Folder ] [ Ok

Images Directory: Choose a folder containing images.

The images within that folder will appear as records in a single table that can then be
mapped to an image in the scene graph.

To bind a scene object to Image data see Data binding further in this document.
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Movies

Browse For Folder u

Browse to a directory containing movie files.

4 | Project Folder -
[ | J8 3D Objects
./ Backups
. Clip Files
. Effects
| |, Fonts

= 1) Images

= 1 Messages
| b Movies|

|I .. Modes

« . Playlists

. Templates

[ Make Mew Folder ] [ )4

Movies Directory: Choose a folder containing movies.
The movies within that folder will appear as records in a single table that may then be
mapped to a movie in the scene graph.

To bind a scene object to Movie data see Data binding further in this document.

Google Docs Spreadsheet
A Google spreadsheet can be configured to supply the data for a data object.
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Google Account Authentication M E
Please authenicate your Google account; your credentials are never accessed or persisted.
Sign in with your Google Account 3
Enter your email
| Next ‘
Find my account -

To access a Google spreadsheet the user must first log into the google account where the
spreadsheet exists.

Username/Password: Username must include @gmail.com or appropriate. Clicking next
will prompt for the password.

Spreadsheet Selection: All spreadsheets associated with the Google account will show up
in the drop down list.

Google Spreadsheet Selection 3|
Spreadsheet ‘ E Ticker - '
MFL
Stocks
Weather

To bind a scene object to Google Docs data see Data binding further in this document.
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Parameters

|7 Data Object Settings

@ Source Filter 5]
Column Edit

] Parameters <a Back

@ Use All Rows

I Type Parameters

Table

Scene Custom Query

All Rows Where Column v| [i; v] |

Binding - Tree [F]Call ||| Column  Clear All Bindings

Away Score Team Home | Teamn Away

Away Team Tampa Bay MY
Home Score

Home Team

Version: 2.0.0.53 [ ok ][ conea |

Parameters are storage containers for data. Parameters have names and values. Users can
create and modify parameters from Lyric itself or through Lyrics API (LEIF). There are
“Application” parameters which are available to every scene. These can be considered
“Global”. There are also “Scene” parameters which are available only when the associated
scene is recalled. Scene Parameters are saved with the message.

To configure Parameters access the Parameters List in the View dropdown. For information
on creating Parameters in Lyric see the Parameter topic.

When Parameters are available in Lyric they will display in the Bindings panel when the
Parameter type (Application or Scene) is selected from the table of the Source panel.

To bind a scene object to Parameter data see Data binding further in this document.
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Parameters E
Application | Scene

+ Add x Remove

MName Value

Also see Parameters List

Editing a Data Source

Once a Data Source has been configured it can easily be edited by clicking the Data Source
Type Icon displayed under the Source title (top left of Data Object Settings menu).

ﬁ Source
- ]

] Text

Changing a Data Source

To change a Data Source click the Back button in the Source area of the Data Object
Settings. This will return the user to the list of data types available.

<3 Back

Filtering Data

Once a data source and table have been selected, a preview of the data will appear in the
Binding Preview display in the Data Object Settings panel. The Filter parameters can be
customized to capture specific data.
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% Source Filter a
Col Edit
Text 4 Back olumn
File \Deocumentation Lyric X\Data Object Files\GOALTODAY. bt © Use All Rows
© All Rows Where Column |

Table GOALTODAY et

©) Custom Query
SELECT * FROM [GOALTODAY. ]

Binding || Tree [] Cell Clear All Bindings

Goals Today i) Player Name +  Team Name - Goals Today - Goals YTD -
Goals YTD B[ T player Team Today Y-T-D#)
Player Name B
Team Name [Z | | peter Bondra Washington 3 e
Marian Gaborik Minnesota 3 2
Michael Peca Ny Islanders 2 2
Miroslav Satan Buffalo 2 2
Daniel Alfredsson Ottawa 2 3
Darcy Tucker Toronto 7 18
Roman Hamrlik Ny Islanders 2 7
Curtis Brown Buffalo i 16
Andy Delmore Nashville 1. 14
Evgeni Nabokov San Jose 1 1
Version: 2.0.0.53

Filter

=
Column Edit

@ Use All Rows

1 All Rows Where Column * lis

() Custom Query
SELECT * FROM [GOALTODAY ]

Column

The column selector allows the user to choose a subset of the table columns to preview.
This is useful when the data contains a large number of columns and minimizes horizontal
scrolling in the Binding panel.

To access the Column Selector:
1. Click the Edit button at the top right of the Filter group box.
2. Either click individual checkboxes to display the specific columns, or check the All
checkbox to display all columns.
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Calumn Selector @

[Player
Team
Today
¥-T-D &)

7] Al oK ] [ Cancel

Data Filters

A variety of data filters can be applied to display specific information.

e Use All Rows

e AllRows Where Column

e Custom Query
All data filter types can be used to reduce the content of the data to specific results desired
for display on output (eg. displaying only local team stats from a data source containing stats
for the entire league).

Use All Rows

All rows within the selected table are included in the resulting data set. This is the default
filter setting.

i@ Use All Rows

All Rows Where Column
Enables filtering based on the value of a particular column using simple comparisons such as

is’, 'is not', ‘is less than’, ‘is less than or equal to’, ‘is greater than’ and 'is greater than or
equal to’. The first dropdown to the left will display all column headers of the configured data
format. The next dropdown displays the comparison and the last editable field takes simple
text input to use in the query. The Query is displayed in the box at the bottom of the Filter

Config panel and the bindings preview window is immediately updated to reflect the filter.
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Filter =
Column Edit
(©) Use All Rows
@ All Rows Where Column Team - H‘Tampa E
() Custom Cuery ey

SELECT * FROM [GOALTODAY.txt] WHERE [Team] = ‘Tampa | IS less than
is less than or equal to

is greater than
is greater than or equal to

For example, the Filter set to All Rows Where Column Team is ‘Tampa Bay' displays the
following results in the Binding Preview:

Player Name - Team Name - Goals Today - Goals YTD -
(Player Team Today Y-T-D #) u
Er— - : z
Nikita Alexeev Tampa Bay 1 2
Sheldon Keefe Tampa Bay 1
Ben Clymer Tampa Bay 1 12
1

Dan Boyle Tampa Bay

Custom Query

The Custom Query filter a query to be directly entered. Most data sources use SQL for these
queries, however RSS, XML, Web and AP Web Feed use XPath. Changes to the query text
is reflected in the Binding Preview in real time, so broken or incomplete queries may result in
an unavailable preview.

(@ Custom Query

SELECT * FROM [GOALTODAY ]

Using Parameters in a Query String
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Parameters are storage containers for data. Parameters have names and values. Users can
create and modify parameters manually from the Parameters list or by a macro, LEIF or
through the Intelligent Interface. There are “Application” parameters which are available to
every scene. These can be considered “Global”. There are also “Scene” parameters which
are available only when the associated scene is recalled. Scene Parameters are saved with
the message.

Parameters can be used in data filters to return a dynamic set of data. Changing the
parameter value in the Lyric Parameters List changes the query, which in return changes the
data set available to the Data object. Parts of the query string can contain the parameter or
the entire query string itself can be stored as a parameter. Having parameters in query
strings makes the data set bound to the scene dynamic at run time.

For more information on how to set a Lyric Parameters List that can be reference in a query
please refer to the Parameters List help file.

Parameters E

Parameters |'ﬁmeline |

Application | Scene

—

+ Add x Remove L}
| Mame Value |
Team Away Tampa Bay

Application Parameters in the query string are phrased as {ApplicationParameterName}.

Filter =
Column Edit
™) Use All Rows
) All Rows Where Column * |is v]

(@ Custom Query

SELECT * FROM [GOALTODAY tet] WHERE [Team] = {Tearn Home}' or [Team] = '{Team Away]'
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Using the Parameter the operator can simply change the value of the parameter in the
Parameters List and the data will automatically reflect the change.

Player Team Today * Y-T-D#
Dimitri Khristich Washington 1 6
Brad Richards Tampa Bay 1 is 16
Nikita Alexeev Tampa Bay ! 4
Sheldon Keefe Tampa Bay 1
Ben Clymer Tampa Bay 1 12
Dan Boyle Tampa Bay 1 6

Additionally, Scene Parameters can be used in the Query String. Scene Parameters are

phrased as {Scene::SceneParameterName}.

Parameters can be used to make URLs for Web and RSS and JSON data sources, as
shown in the below example of the Scene Parameters list and URL in the Data Object

source URL.

Parameters |Trmer'me |

+ Add x Remowe

Mame Value

Web Configuration

Web Address

https://weather.com/weather/today/|/{scene:codel4:US

Retrieval Options

Download Interval seconds

Save Location 2AppData®\ ChyronHego\Data Object g

Strip Embedded HTML Tags

Use System Proxy Settings

Advanced

Transform XML with Custom XSLT

| [-]

Transform Attributes Allow DTDs

Collapse Nodes
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Binding Preview

The left side of the Binding Preview displays all the elements in the current scene that can be
bound to the data. To the right it displays a visual representation of the data as it has been
parsed, including any filters that have been applied and the column visibility that has been set
up in the Column filter.

Formatting Column Data

The data parsed into the binding columns can be formatted to ensure it is available in the
correct format to its Bound object.

When in Column or Cell Data Binding: To format the data in a column of the binding preview,
click on the Column Header. The options of Format Column and Clear Formatting are
available.

When there is a format configured for a column or cell it will appear with a cog icon beside
the column header.

{Phyel *  Team Today ¥Y-T-D #) =
w Format Column ... | Washington 3 33 1
M Clear Formatting Minnesota 3 25 3
Michael Peca Ny Islanders 2 2
Miroslav Satan Buffalo 2 22
Daniel Alfredsson Ottawa 2 33
Darcy Tucker Toronto 2 18
Roman Hamrlik My Islanders 2 7
Curtis Brown Buffalo 1 16
Andy Delmore MNashville 1 14
Evgeni Nabokov San Jose 1 1
Adam Graves San Jose 1 13
-
(Player ]

When in Tree Data Binding: To format the data in the tree view click on XML tag and right
click. The options of Format Value and Clear Formatting are available.

When there is a current format configured for a column it will appear with a cog icon beside
the column header.

When you select Format Column from the Column Header the Format Data window will
open.
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Element Bindings =
= team D
@vh V
@id UCSD

= Format Value k L

Clear Formatting
@record 4-
Edit Bindings

Clear Bindings

= linescore
@peri
@line 0,0
@score 0 _
@shotline 3,7
@shots 10

The Format options when clicking on the Element in the Tree Data Binding view.
@time 5:45 pm £
When you click Format Value the Format Data window will open.

Text Formatting
The Text format menu provides the ability to add a Prefix and Suffix to the data in that

column.
(Grmaoe T =
Sample
g:tr:ber Peter Eondra
Time
7] Add Prefix | |

Add Suffix

Trim Whitespace
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A prefix is content that should be displayed before the original column data and a suffix is
content that should be displayed after the original column data.

When a Prefix and Suffix are added, the Sample will reflect how the column content will
change.

Add Prefix EAMHLAPlayers', P
Add Suffix Jprg =

[] Trim Whitespace

Sample

IANHL\Players\Peter Bondra,jpg

Clicking the Set Image/Movie Tag Icon E will open a dialog to select an image or movie
that can be used to separate rows of data. This can be very useful when using column data
to populate a crawl or headline animation.

The format of the imported image or movie will be: \img C:/Image.png

Where “\img” represents the type of file. To configure a Movie the \mov tag is used.
“C:/Image.png” represents the file path.

The image cannot be resized, however it can be positioned in line with the text content. To
move the image up or down within the text template follow the filename with a “;\xN” (for
horizontal adjustment), “;\yN” (for vertical adjustment) or “;\xN\yN” (for horizontal and vertical
adjustment) where N is the movement value (e.g. \img C:/Image.png;\x5\y10).

The \trans tag can also be used at the head of a prefix string to trigger the new information
on with a specific transition that exists in the message (e.g. \trans New Headling;). In this
example the new content trigger the “New Headline” transition. Note the semicolon after the
transition name.

Trim Whitespaces will remove leading and trailing non-printable characters.

Number Formatting

Numeric data can be formatted using the Number format menu.

Decimal Places determines how many numbers will display after the decimal.

Use Thousands Separator will format numbers with a comma between the thousands and

hundreds.

Currency will add a symbol before or after the number (e.g. $10 or 10 €) or can also add the
country’s currency code (i.e. USD or EUR).

The Math field offers the ability to Evaluate the field’s data. This supports basic arithmetic for
modifying field data.
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e E.g. “$Value + 31.0” will add the number 31.0 to any data field formatted in this

manner.

The Additional Text Options are configured as per the Text menu. Refer Text Formatting

above.

Text

Date
Time

Date Formatting

,

Sample

3

Decimal Places 0 E

Use Thousands Separator

S5

Currency ’

Math

[] Evaluate SVALUE

Additional Text Options

[7] Add Prefix

7] Add Suffix

The date formatting menu offers the ability to select from preset date formats or an input to

create custom formats.

For additional information on creating custom date/time formats double click on the 9 icon
beside the input field, or navigate to:

https://msdn.microsoft.com/en-us/library/8kb3ddd4.aspx

The Additional Text Options are configured as per the Text menu. Refer Text Formatting

above.
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i B’
S

Sample
3

1/5/2000

Wednesday, January 05, 2000
Wednesday, January 05, 2000 12:20 pm
Wednesday, January 05, 2000 12:20:15 prn
1/5/2000 12:20 pm

1/5/200012:20:15 pm

IHF‘II mn.rn';

Time Formatting

Additional Text Options

Add Prefix

7] Add Suffix

The time formatting menu offers the ability to select from preset time formats or an input to

create custom formats.

For additional information on creating custom date/time formats double click on the < icon
beside the input field, or navigate to:
https://msdn.microsoft.com/en-us/library/8kb3ddd4.aspx

The Additional Text Options are configured as per the Text menu. Refer Text Formatting

above.
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i B’
S

Text Sample
Mumber
Date 3

12:20 pm
12:20:15 prn
12:20

12:20 pm
12:20:15
12:20:15 pm

Additional Text Options

Add Prefix

7] Add Suffix

Data Binding

When the data is filtered and the columns are formatted as desired, the available objects in
the scene can be mapped to the data columns, individual data cells or tree data structures.

From the buttons at the top of the binding pane click the type of data binding appropriate.
Tree Bindings is not available for all Data Source types.

Binding | Tree [H] Cell Clear All Bindings

The Clear All Bindings button will remove any previously associated data bindings.

The Object Panel to the Left of the Data Object Settings Binding area will display all objects
in the scene that can be associated with data. If they already have an association they will

display with a database icon B beside them.
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Goals Today
Goals YTD

Player Name

HEdd

Team Mame

Column Data Binding

To bind an object to a Column of data simply drag the object name from the Object panel
onto the column of data required.

Binding | | Tree [ Cell Clear Al Bindings

Goals Today - - - -
Gaale MTD (Player v Team Today Y-T-D#)
sshington 3 E
Team Name 3 5
Michael Peca Ny Islanders 2 21
Miroslav Satan Buffalo 2 22
Alternately the object from the dropdown above the column header.
Binding | Tree [H] Cell Clear All Bindings
Goals Today E - - -
Goals YTD e Team ~ | Today Y-T-D #) =
oals | oda
Player Name Goals YTD 2 Washington 3 3
Team Name Minnesota 3 25
. Team Name || Ny Islanders 2 27
| Miroslav Satan | Buffalo 2 22

When an object has been bound to a column the column will appear yellow and the name of
the object will be in the dropdown above the column header.

Player Name - Team Name - Goals Today - Goals YTD -
(Player Team Today ¥-T-D #) u
Marian Gaborik Minnesota 3 25
Michael Peca My Islanders 2 2
Miroslav Satan Buffalo 2 22
Daniel Alfredsson Ottawa 2 33
Darcy Tucker Toronto 2 18
Roman Hamrlik My Islanders 2 1
Curtis Brown Buffalo 1 16
Andy Delmore Nashville 1 14
Evgeni Nabokov San Jose 1 1
Adam Graves San Jose 1 13

To clear an individual column association with an object click on the dropdown and select the
blank option. Dragging a new object onto the column will replace the previous association.

Columns can only have a single object associated with them.
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Cell Data Binding

To bind an object to a cell of data simply drag the object name from the Object panel onto the
cell of data required. Additional scene objects can be associated by dragging and dropping
more than one object.

Binding | | Tree (] [E] Column  Clear All Bindings

Goals Today Today Y-T-D#)

Goals YTD Peter Bon HiSSMs 3 33

Player Name - 8| [ Marian Gaborik Minnesota 3 25

Team Name Michael Peca Ny Islanders 2 21
Miroslav Satan Buffalo 2 22
Daniel Alfredsson Ottawa 2 33
Darcy Tucker Toronto 2 18
Roman Hamrlik My Islanders 2 7
Curtis Brown Buffalo 1 16
Andy Delmore Mashville 1 14
Evgeni Nabokov 5an Jose 1 1
Adam Graves San Jose 1 13
Teemu Selanne San lose 1 23
Murray Baron Wancouver 1 1

Alternately scene objects can be associated with a cell by right clicking on it and selecting
Edit Bindings. The Select Binding Targets menu opens which will list all the objects in the
scene. More than one can be selected.

i = = ™
Row O

Column  (Player

Target Mame

Goals Today
Goals YTD

Player Mame
Team Mame

When a data association has been made, the cell will appear grey and the name of the
associated scene object and a database icon will display beside the cell data.
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(Player Team

If a cell has more than one object binding, hovering over the data icon in the cell will display a
tooltip with a list of all bound objects.

To clear an individual cell association with an object right click on the cell and select Clear
Bindings. To edit a cell binding right click and select Edit Bindings.

Note: Although Cells can have multiple object associations they can only be formatted a
single way. The data provided to both objects will be the same.

Tree Data Binding

When binding the Tree Data an additional 3 view selections appear in the Binding section.
They enable the ability to expand the tree structure (Expand All), collapse the tree structure
(Collapse All) or just see the elements with data associations (Compact).

Expand All Collapse All Compact

The data in the element window can be expanded similarly to Windows Explorer (+ to
expand and - to collapse).

To bind an object to a element in a tree of data simply drag the object name from the Object
panel onto the element required. Additional scene objects can be associated by dragging and
dropping more than one object.

Binding (=] Tree | [ Cell (] Column  Clear All Bindings | Expand All Callapse All Compact

Away Score Element Bindings

... D
Home Score = team
Home Team @vh V

@id UCSD

@name UC' Away Team
@code
@record 4-8-0, 4-6-0 CCAA

= linescore
@periods 2
@line 0,0
@score 0
@shotline 3,7

Alternately scene objects can be associated with an element by right clicking on it and
selecting Edit Bindings. The Select Binding Targets menu opens which will list all the objects
in the scene. More than one can be selected.
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Element Bindings =
= team D
@vh V
@id UCSD
@name UCSD
Bcode Format Value
@record 4- Clear Formatting
linescore Edit Bindings
totals Clear Bindings
player
player
player
player
8 ™
Select Binding Ta rge__bléu
Target Mame
& Away Score
Away Team
Home Score

[] Home Team

When a data association has been made, the element will appear yellow and the name of the
associated scene object will display in the bindings column beside it.

FOR MORE INFORMATION ABOUT CHYRONHEGO VISIT:
HTTP://ICHYRONHEGO.COM/


http://chyronhego.com/

LyricX Data Object Guide
Page 35

Element Bindings
-m
@vh V
@id UCSD
@name UCSD Away Team
@code

@record 4-8-0, 4-6-0 CCAA
= linescore
@periods 2
@line 0.0
@score
@shotline 3,7
@shots 10

To clear an individual element association with an object right click on the element and select
Clear Bindings. To edit a element binding right click and select Edit Bindings.

Note: Although elements can have multiple object associations they can only be formatted a
single way. The data provided to both objects will be the same.

Binding Data to the Control Panel

Once data configuration and filtering is set, the resulting columns can be mapped onto
controls in the Scene Control Panel by editing the value of the combo box above each
column.

Whenever data is requested from the data source (Update or Move Next command), then
those columns with bound control names will be updated accordingly with data from the
appropriate record for that column.

Data Object Settings Showing Data Binding

Keyframing Data Object Actions

Once a data source has been configured the Data Object is added to the scene. Like many
objects in the scene, it has a track that can be added to transitions and keyframes with
actions can be added. These keyframes can contain commands for the data that has been
associated in the Data Object.

The General Properties displays the Node Information, Data Source details which are not
keyframeable. It also displays any actions configured for this frame, of the current transition,
in the animation.
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General i}

General | Font 5tyle | Transform | surface | Events 4 P

Data Object > Data Object 1 &

4 MNode Info
Mode Mame Data Object 1
Description

m

4 Data Source

Files\Stat Crew\SOGAME. XML

OnRead Preview

4 Action

Node Information
Node information is where an name can be given to the Data Object node.

Data Source
Data source will display the configured data. To edit this source, formatting or bindings simply
click on the Edit button to return to the Data Object Settings menu.

OnRead Preview
Channelbox doesn’t read - sends to output directly. No preview. Onread preview - gets latest
data from source on read and displays on canvas.

Actions

Actions are functions related to the Database that the message can trigger at a frame in the
animation. The data object can employ various actions to navigate through data or execute
specific functions with the data. Data navigation commands move the “cursor” (where it is in
the data record set).

To create an action at a keyframe click the Add button at the bottom of the action window.
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4 Action

+ Add
A selection of available Data Object actions is displayed. An action can be added by clicking.
MowveEnd
MoveFirst
MoveHome
Mowvelast
MowveMext

MowvePrevious
Refresh
Update
Display

Clear

If the Data Object track is not already in the transition, Lyric will popup a dialog asking the
user if they would like to add the Data Object track to the transition.

@ "Data Object 1" is not in transition "Effect In". Add it?

| ok || Cancel |

MoveEnd

Moves cursor AFTER the last record in the record set. This will be an empty record because
it is after the last record.

Move First

Moves cursor to the first record in the record set.
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Move Home

Moves cursor to BEFORE the first record in the record set. This will be empty because it is
before the first record.

Move Last

Moves cursor to the last record in the record set.

Move Next

Moves cursor to the next record in the record set.

Move Previous

Moves cursor to the previous record in the record set.

Refresh

Keeps the cursor on the current record, but refreshes the contents from the data source.

Update

The Update command will grab the current data in the record set at the navigated to pointer
position and populate the objects in the canvas. It will not update output until a Display
command is performed.

Display
The Display command will display to output the updated data for the linked object.

Clear

Data associated with this data object will be cleared, regardless of pointer position. This will
not move the cursor in the data record set.

Multiple Actions

Multiple actions can be configured to a single keyframe. To configure multiple actions simply
add them by clicking the Add button.

4 Action

MoveFirst
Update
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Moving Actions

Actions will be performed in the order they are displayed in the list, starting at the top. To
reorder the list simply drag and drop the Action to a new position in the list.

Deleting Actions

To delete an action simply click on the * at the right of the Action.
All actions on a keyframe can be deleted by deleting the keyframe from the track, and all
actions in a transition can be deleted by removing the track from the transition.
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Data Object Events

The Data Object Events dialog is accessed from View > Event Properties and is for
asynchronous (or outside of the timeline) triggers. Instead of happening at a specific
keyframe, the listed actions will be triggered upon completion of the configured data object
event (i.e. End of Data, On MoveHome).

Events i |
eral | Font Style | Transform | Surface Events |4 [ 3

| Data Object > Data Object 1

4 Event

Event Properties o

m

On MoveEnd

On MoveFirst

On MoveHome

On Movelast

On MoveMext

On MovePrevious i3

4 Actions

Action Type Properties

Triggers can be configured on the following Data actions:

e End of Data - Upon moving beyond the last record in the data set, or last + 1.

e On MoveEnd - Upon a MoveEnd command being executed in this data object.

e On MoveFirst - Upon a MoveFirst command being executed in this data object.

e On MoveHome - Upon a MoveHome command being executed in this data object
(Home is before first, or first-1).
On Movelast - Upon a MovelLast command being executed in this data object.
On MoveNext - Upon a MoveNext command being executed in this data object.
On MovePrevious - Upon a MovePrevious command being executed in this data
object.
On Refresh - Upon a Refresh command being executed in this data object.
On Update - Upon an Update command being executed in this data object.

FOR MORE INFORMATION ABOUT CHYRONHEGO VISIT:
HTTP://ICHYRONHEGO.COM/


http://chyronhego.com/

LyricX Data Object Guide
Page 41

On Display - Upon a Display command being executed in this data object.

On Clear - Upon a Clear command being executed in this data object.

OnDataChange- Upon any change in the data source

OnTargetDataChange- Upon change of any bound data. (Only works in Cell mode or

Tree mode.)

e OnTargetDataChange is exclusive to cell bound mode only, and will never fire in
column bound mode. Whereas OnDataChange will fire in Column bound mode, and
sometimes in cell bound mode when data other than bound data has changed.

e OnTargetDataChange and OnDataChange notifications occur whenever
updates/changes are detected in data sources that support this functionality. At this
time the following data sources support notifications of this nature:

Hego Data Engine

JSON

Web

XML

Parameters

o O O O O

By default, Data Objects have a trigger set up to Display on Update. The reason for this is
so the Display command will only be executed on the completion of the Update command
regardless of how long it takes to update, and a Display command will not be displaying old
data or data from the previous record.

If the user requires a display to execute at a specific time in the timeline, for instance when
the updating field is hidden, this trigger should be removed and the Display event should be
entered on the timeline as a Data Command event.

In order to update and display data On DataChange in Column mode, Move(MoveFirst,
MoveNext...etc) or Refresh command is required in addition to Update and Display
commands. In column mode the cursor starts at BOF(Before the data) and has to moved in
order to get the first data or Refresh command to get the updated data. Therefore on
Update itself, new data is not applied to bindings. Move commands is needed move the
cursor to requested location or Refresh command to get updated data ,then Update
command will add new data to the binding ,and Display will display it.Also Refresh command
can be used to move the cursor from BOF to first pos.

For information on configuring the Actions of these Events refer to the Trigger Track
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